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Contact and Support Information
Product and account information can be accessed by visiting Customer Support online at
support.cch.com. In addition to product and account information, the Customer Support site offers
answers to our most frequently asked questions, forms release status, Knowledge Base articles,
training videos, and operating systems compatibility. Access to these features is available 24/7.

The following website provides important information about the features and updates included in
all CCH® ProSystem fx® Tax releases: Release Notes

Visit the Application Status web page to view the current status of our CCH applications. The
Application Status web page is updated every 15 minutes.

Go to Contact Us to find information on topics such as Sales and Billing, as well as options to Open
a Support Case or Chat with a Representative if you need assistance.

Information in Tax Year 2017 Release Notes
Tax Release Notes inform you of the enhancements and updates that have been made to Tax
products and systems with the current release.

Updates provided in the Release Notes include the following:

Contact and Support information
Updates to the Tax technology (electronic filing updates, Pro Forma/Roll Forward,
Organizer, technology enhancements)
Updates made to Tax products (form additions and updates, diagnostic updates, changes
caused by regulatory updates)
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Highlights for Release 2017.01000

CCH® ProSystem fx® Tax

QuickBooks® Import for 1040 Returns
New for tax year 2017, you will be able to import data from Quickbooks®. We will provide this
import through our G/L Direct feature. G/L Direct now has a standard import for Quickbooks® for
Individual (1040) returns.

You can import QuickBooks® data into Schedule C, E, and F.

The source of the import is an Excel® file created by QuickBooks® (either online or desktop
version).
The G/L Direct Help file has instructions on how to create an export file in QuickBooks® for
importing into G/L Direct.

Federal/States Returns Processed Detail Report
The detailed Returns Processed report, available in Office Manager (Print Reports > Fed/state
returns processed), includes the detail of returns processed at least once. In addition, the report:

Begins tracking 2017 returns calculated for the first time after this release.
Is produced in Excel® automatically.

Has options for filtering by Tax Year (only 2017 is available now), Tax product, Office
group, Date range or Client ID.
Allows you to add additional sorting and filtering in Excel®.

CCH® Global fx Tax

Close/Logout Security Enhancement
A new Logout menu link option and updates to the Close link function in Global fx have been
added to strengthen customer data security. This is to avoid the possibility of others using your
SSO session to make updates prior to the automatic system log out at 30 minutes of inactivity.

Important points to remember are:

If you only have one SSO application open selecting Close will close your application window
and log you out of your SSO session.
If you have multiple SSO applications open selecting Close will only close your application
window.
If you have one or multiple SSO applications open selecting Logout will close your primary
application window, log you out of your SSO session, and provide a prompt for logging back
in.
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CCH® ProSystem fx® and CCH® Global fx Tax

Extender Legislation
With tax season approaching and Congress still considering legislation that impacts 2017 tax
returns, the IRS has begun releasing forms with flexibility to accommodate retroactive changes to
2017 tax law. The current IRS approach is to leave the forms in 2016 format, replacing the line
descriptions with lapsed tax provisions of "Reserved."

To date, the following forms contain reserved fields:

Form Title System

1040 U. S. Individual Income Tax Return 1040

1040,
SCH A

Schedule A Charitable Contributions Worksheet 1040

1040A U.S. Individual Income Tax Return 1040

1041,
SCH D

Schedule D Tax Worksheet 1041, 990

4136 Credit for Federal Tax Paid on Fuels
1040, 1065, 1120,
1120S, 1041

5695 Residential Energy Credits 1040

6478 Biofuel Producer Credit
1040, 1065, 1120,
1120S, 1041

8689
Allocation of Individual Income Tax to the U.S. Virgin
Islands

1040

8835
Renewable Electricity, Refined Coal, and Indian Coal
Production Credit

1040, 1065, 1120, 1120S

8844 Empowerment Zone Employment Credit
1040, 1065, 1120,
1120S, 1041

8845 Indian Employment Credit 1040, 1065 1120, 1120S

8864 Biodiesel and Renewable Diesel Fuels Credit 1040, 1065, 1120, 1120S

8900 Qualified Railroad Track Maintenance Credit 1040, 1065, 1120, 1120S

8904 Credit for Oil and Gas Production from Marginal Wells
1040, 1065, 1120,
1120S, 1041

8908 Energy Efficient Home Credit 1040, 1065, 1120, 1120S

8911 Alternative Fuel Vehicle Refueling Property Credit 1040, 1065, 1120, 1120S
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Office Manager Updates

New Options

A new drop-down list for “Electronic filing stopped notification to preparer option” has been
added to Electronic Filing Notifications for all return systems.
An option has been added to both the 1040 Options and the 1041 Options providing the ability
to select the format of the income from passthrough statements at the office group level
instead of on a per return basis. This option will be available for both ProSystem fx and
Global fx.

Feature Changes

The “Do not prepare separate letters for certain federal forms” for Letters and Filing
Instructions has been changed to “Prepare separate letters for certain federal forms.” The
change applies to both ProSystem fx and Global fx, and to Individual, Partnership,
Corporation, S Corporation, Fiduciary, and Exempt Organization systems.
The “Print ERO signature on Form 8879” on the Electronic Filing Options, ERO tab, has been
replaced with a new drop-down list, “ERO Signature options for Form 8879.” The change
applies to both ProSystem fx and Global fx, and to Individual, Partnership, Corporation, S
Corporation, Fiduciary, and Exempt Organization systems. The option applies to tax years
prior to 2017.
The “Do not automatically carry extension payment amount to the return” on Miscellaneous
Options as been changed to “Automatically carry extension amount to the return.” The
change applies to both ProSystem fx and Global fx, and to Individual, Partnership,
Corporation, S Corporation, Fiduciary, and Exempt Organization systems. The option applies
to the 2016 tax year and higher.

Pop up Messaging
Once you log in to the Tax program, our new Message Center displays important system and
software information, when available, from Wolters Kluwer.

Diagnostics Sign-Off
You can now "sign-off" the Caution and Informational diagnostics once you have reviewed them.
Once you sign off, we will display the user ID and date and time of sign-off.

If there are multiple occurrences of the same diagnostic, you can sign off on them all or just
the current one.
If needed, you can remove the sign-off on a diagnostic and it will return to the Open
diagnostics tab.
The diagnostics list is now collapsible by category, then further by unit.
The diagnostics are displayed in tabs – Open, Signed-Off, and All.
Diagnostics that link to fields will display the link icon to the left of the diagnostic item.
There is also a new print option “Print only open diagnostics” that allows you to print only
the open diagnostics with the return.

Global fx Utilities
The Global fx Utilities to Upload Returns, Download Returns, Upload Firm Information and Office
Groups have been moved to CCH ProSystem fx Office Manager. To upload/download returns
between Global fx and your local ProSystem fx database and to upload your firm configuration and
office groups from your local ProSystem fx database, select the Global fx Utilities menu within
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your local ProSystem fx Office Manager application. Unlock Uploaded Returns has moved from the
Tools menu to the Global fx Utilities menu.



Accessing Tax Instruction Information
Methods used to access Tax instruction information have been streamlined to ensure that you are
finding the most up-to-date information available. As part of this initiative, the Tax Field/Form
and Cross Reference guides will no longer be available. Instead, you can find all of the same
information in the following locations:

Technical User Guides are available on the product support pages under each product's
Guides tab.
Field/Form and Cross Reference help is available from within the software as in the past, but
can also be found in Knowledge Base article CCH ProSystem fx Tax: Tax Help Files
(SW42734).
Additional information and videos about using Help tools from within the software is
available in Knowledge Base article How do I access Cross-Reference Help and the other help
options in CCH ProSystem fx Tax? (SW756).

Estimate Printing Enhancement
You can now select multiple quarters or all quarters when printing estimates.

K-1 Printing Enhancement
You can now print just one K-1 or select multiple K-1 print packages from within a return.

PDF Attachments Printing Enhancement
We added the ability to print attached PDFs whether the returns are selected for e-file or not.

Electronic Filing Status System
We added the following enhancements:

EFIN Manager

With our new EFIN Manager, users can easily view, modify and track their EFINs and Vendor
Control Numbers in one central location.

EFIN Manager is available within the Electronic Filing Status System by selecting
Admin, located to the right of your name, then EFIN Manager. This is available to
you if you have release return rights.

Note: You will need to select an Office before the menu option for EFIN
Manager will display. Office cannot be set to “All” in order to access EFIN
Manager.

For a new EFIN, add the EFIN and the IRS Tracking Number into EFIN Manager.

Note: This replaces the need to upload your IRS Application Summary to us.

You may also mark an EFIN as active/inactive, assign account number(s) to an EFIN,
hide an EFIN from view in EFIN Manager, or delete an EFIN from our database.

Note: Once deleted, an EFIN cannot be restored. In this case, you will need to
add as a new EFIN.
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Banking Info Columns
We added two additional default columns, Bank Info and State Bank Info, to the e-
filing Status and Release Return(s) tabs. These columns may be relocated or removed
from your view via “Select Columns.” Restore Default View within “Select Columns”
will bring them back into your view.
We added Bank Account Num (Number) as a selectable column available via “Select
Columns.” This column will provide the last four digits of the first Federal bank
account number listed.

Return History. We added the version number to the Return History page, allowing you to
verify the version number when electronically filing multiple versions of the same return.

You can view the return ID, including the version number, on the Return History page.

Note: This applies to returns uploaded following the 2017.01000 release version only.

Logout. You may now logout of all CCH ProSystem fx web or CCH Global fx applications
simultaneously. “Close” remains to simply close the current browser window.
Preparer Notifications. Signers can now elect to receive e-mail notifications for returns in
a stopped status using a new option in Office Manager (Configure Applications > Tax
Preparation > Electronic Filing Notifications > All systems).

Common reasons why an electronic filing transmission is in stopped status are:

IRS and state schema validation errors

Missing account, state, or EFIN information

Invalid EFIN information

Messaging

We added a new message for the electronic filing maintenance page to notify you
when the IRS is down.

We added a new message during export to notify you when the maintenance page is
up.

CCH® My1040Data
CCH My1040Data is now available for creating 2017 web-based organizers for your clients.

We added the following enhancements:

The location of client-entered (taxpayer-entered) notes in My1040Data will move near the
beginning of the PDF file to ensure they are not missed by the accountant.
The previous “Unemployment Compensation” item on the left menu under “Income &
Deductions” will change to “1099-G (State & Local Refund, Unemployment)” in order to be
more descriptive. The entry screen will now include a description of the types of items that
should be entered there.
In order to improve client (taxpayer) confidentiality, My1040Data will force the client to
change the system-generated password when first logging into My1040Data. The client’s
newly chosen password will no longer be visible to the My1040Data Toolkit administrator.

Beginning with tax year 2017, the Toolkit will only display passwords created by the
Toolkit or by the accountant.
In the case of client-created passwords, the Toolkit will display "Changed by Client"
in the Password field, but not the client-created password.
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Important: The 2017 version of My1040Data Toolkit will only open client (taxpayer) files
related to tax year 2017. Please ensure you have retrieved all of your clients’ tax year 2016
files before installing the 2017 version.



CCH® ProSystem fx® Tax Notebook and CCH® ProSystem fx® Tax
Notebook Toolkit

Tax Notebook Toolkit is now available for processing and for creating Tax Notebooks.
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Tax Product Enhancements in Release 2017.01000
Click one of the links below to read about the tax application enhancements included with Release
2017.01000.

Worksheet View
Individual (1040) Product Enhancements - Worksheet View

Partnership (1065) Product Enhancements - Worksheet View

Corporation (1120) Product Enhancements - Worksheet View

S Corporation (1120S) Product Enhancements - Worksheet View

Fiduciary (1041) Product Enhancements - Worksheet View

Employee Benefit Plan (5500) Product Enhancements - Worksheet View

Exempt Organization (990) Product Enhancements - Worksheet View

Estate and Gift (706/709) Product Enhancements - Worksheet View

Interview View
Individual (1040) Product Enhancements - Interview View

Partnership (1065) Product Enhancements - Interview View

Corporation (1120) Product Enhancements - Interview View

S Corporation (1120S) Product Enhancements - Interview View

Fiduciary (1041) Product Enhancements - Interview View

Employee Benefit Plan (5500) Product Enhancements - Interview View

Exempt Organization (990) Product Enhancements - Interview View

Estate and Gift (706/709) Product Enhancements - Interview View
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Tax Product Enhancements 2017.01000 - Worksheet View

Individual (1040) Product Enhancements - Worksheet View
Return to Table of Contents.

Federal
We aligned the fields on the Consolidated 1099, 1099-INT, and 1099-DIV source documents
input so all entries are available on each.
We no longer disqualify e-filed extensions (FD or state) after the due date.

Consistency/Usability Changes

We added descriptions rather than codes in Worksheet drop down fields, so the choice will be
visible without clicking.
We added all allowable fields to all summary grids. This means that, whenever possible, each
Summary grid will now contain all the fields found on the Detail grid.
We added a state e-file estimate grid.
To improve worksheet navigation:

Form 1116 is listed in both Credits and Foreign (Mirrored entries).

Schedule and Form names are explicitly stated.

Rearranged Deduction, Tax and Foreign categories to follow the flow of Form 1040.

Direct Deposit/Debit Report
We appended the scheduled date for withdrawal to the text in the Debit/Deposit column, which
will show when the withdrawal is scheduled for all return types, including estimate payments.

Pro Forma of Estimated Payments
We now pro forma (for informational purposes only) the prior year’s calculated estimated tax
payments in the following year’s return. If there are estimate amounts entered and the
Payments/Penalties > Payments > Federal Tax Payments > Include prior year estimate amounts on
current year return field is selected, we issue a diagnostic indicating we used the keyed amount,
not the memo amount.

Extensions
We added a Prepare All Extensions option to generate required extensions for all taxing authorities
in a return.

The input is on Extensions > Automatic Extension > Prepare all extensions

1040NR, U.S. Nonresident Alien Income Tax Return

We added the ability to e-file Form 1040NR to tax year 2016.
We added Form 1042-S for source document input.

This is a non-calculating library form required for e-file. Amounts entered here do
not carry into the return.
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1099MISC
We added a code for Nonemployee Compensation so the amount will carry to both Other Income
and Schedule SE.

Other Income > Miscellaneous Income > Other > Treat nonemployee compensation as other
income

Form 5471
We added a new Schedule G, Line 3 statement.

Form 8621 Excess
We improved the look and content of this worksheet by changing it to a small font.

Form 8903
Prior year basis, at-risk and passive domestic production loss carryovers will now carry to Form
8903 and be used in the calculation of QPAI.

States

Agreements with State Taxing Authorities (Letters of Intent)
We must comply with the following requirements from States governing paper and e-file
submissions:

Restrictions on Pro Forma (transfer of data)
The following states will not allow us to pro forma driver's license numbers and State
IDs: AL, CT, IA, ID, IN, ME, NC, ND, NE, NJ, NM, OK, WI.
The following states will not allow us to pro forma bank information (account
numbers), driver's license numbers, or State IDs: AR, IL, SC, WV.

This state will not allow us to pro forma driver’s license number, State ID, bank
information, State PINs or locality codes: VA.
The following states require the preparer to confirm pro formaed data: CO, KY, MD,
MN.
The following states require two-step verification of various items: AR, OR.

Most states now require us to include refund/ID theft statements and associated URLs in the
return; this is handled in Help.
We will disqualify the return from e-file if driver's license information is not in the return
for: AL, CT, NM, NY and OH. Per these States, you will not be able to electronically file
these returns until you enter the information.

Alabama
We added Schedule IRC – Irrigation/Reservoir System Credit.

AL Credits > Irrigation/Reservoir System Credit

Arkansas
AR1000CE, Teacher’s Classroom Investment Expense.

Credits > Teacher’s Classroom Investment Expense
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California
We added the following:

State 8878, extension signature document to extension print package.
Schedule X – Amended Return Worksheet.

Colorado

Electronic filing estimates
Electronic Filing > State > Electronically File Estimates

DR 0350 – First Time Home Buyers Subtraction
CO > Income/Deductions > Deductions and Subtractions > First time home buyer
savings account deduction

District of Columbia
We are no longer offering a refund card as an option due to new requirements.

Kansas
There is a new three-bracket rate structure.

Kentucky
We added Schedule KW-2, Kentucky Income Tax Withheld.

Mandatory for paper filed returns only.

Massachusetts
We changed the default for MA bank interest that is applied to MA resident returns.

Michigan
Form 1040X is obsolete; replaced by Form 5530.

Michigan - DTW
We added Detroit Form 5338, Underpayment of Estimated Tax.

Michigan > Cities > Underpayment of Estimate Tax Preparation

Minnesota
We added the following:

Schedule M1529, Education Savings Account Contribution Credit or Subtraction
MN > Credits > Education Savings Account Contribution Credit or Subtraction

Schedule M1SLC, Student Loan Credit
MN > Credits > Student Loan Credit

Schedule M1RCR, Credit for Tax Paid to Wisconsin
MN > Credits > Credit for Taxes Paid

Schedule M1HOME, First-Time Homebuyer Savings Account
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Schedule M1AR, Accelerated Recognition of Installment Sale Gains
Credit for Taxes Paid worksheet for e-file

Missouri - St. Louis
We added Form E-8, Application for Extension of Time to File Business Earnings Tax Return.

Montana

The Amended return is now included on Form 2.
Montana > Amended > Amended

NOL information is now included on Form 2.
Montana > Income/Deductions > Preceding Years Information

Nevada
We added an Application for 30 Day Extension.

New Hampshire

We added Business Profits Tax e-file.
We removed the sole proprietor versions of the Business Profits Tax forms; LLC versions are
available exclusively.

New York
We added the following:

State 8878, extension signature document to extension print package
Form IT-219, Credit for New York City Unincorporated Business Tax

New York > Credits > Credit for NYC UBT (Form IT-219)

Form IT-223, Innovation Hot Spot Deduction
New York > Income / Deductions > Innovation Hot Spot Deduction (Form IT-223)

Form IT-249, Claim for Long-Term Care Insurance Credit
New York > Credits > Long Term Care Insurance Credit (Form IT-249)

Form IT-256, Claim For Special Additional Mortgage Recording Tax Credit
New York > Credits > Credit for NYC UBT (Form IT-256)

Form IT-603, Claim For EZ Investment Tax Credit and EZ Employment Incentive Credit
New York > Credits > EZ ITC and EZ ITC (Form IT-603)

Form IT-607, Claim for Excelsior Jobs Program Tax Credit
New York > Credits > Claim for Excelsior Jobs Program Tax Credit (Form IT-607)

Form IT-398 Input for Assets (like 1120/1120S).
New York > Income / Deductions > Depreciation Schedule(s)

New York > Income / Deductions > Adjustment

Forms W2, W2-G, 1099-G (EF only).
Income > Wages, Salaries and Tips (IRS-W2) > Wages and Salaries (IRS-W2)

Income > Other Income (1099G, 1099K,1099-MISC,W-2G) > Gambling Winnings (IRS-
W2G)
Income > Other Income (1099G, 1099K,1099-MISC,W-2G) > Certain Government
Payments (IRS 1099-G)
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New York - New York City
We added city 8878 signature document to extension print package.

North Carolina
We added Schedule PN, Part-year Resident and Nonresident Schedule.

Oregon
We added the following:

OR-WFHDC, Oregon Working Family Household and Dependent Care Credit Worksheet
Oregon > Credits > Working Family Household and Dependent Care

Retention document for calculating prior year Working Family and Household Add Dependent
Care Credit

Oregon > Credits > Working Family Household and Dependent Care

Pennsylvania
We separated Schedule G-L override logic.

One override no longer requires all fields to be overridden.
Existing input has been updated to include only one column with TS code to indicate
taxpayer or spouse.

Schedule A/B will not split into separate schedules if any overrides are entered.

We now treat the Taxpayer/Joint column as jointly filed input if all other entries are coded
joint and as Taxpayer input if any other entries are coded as Taxpayer or Spouse.

Income / Deductions > Schedule A and Income / Deductions > Schedule B

We added an option to force separate schedules.
Overrides have been expanded to all lines.

South Carolina
We added an Out of State Income/Loss statement.

New adjustment options are added for this on SC > General > Options > SC adjustment
worksheet options.

Tennessee
We added FAE172, Quarterly Franchise, Excise Tax Declaration e-file.

Tennessee > Other > Estimate Preparation Options and Overrides

Vermont
We added the ability to batch e-file extensions.
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Wisconsin
We added the following:

Schedule GL, Gain or Loss on the Sale of Your Home.
WI > Credits > Gain or Loss on the Sale of Your Home

Credit for Taxes Paid worksheet for e-file.
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Partnership (1065) Product Enhancements - Worksheet View
Return to Table of Contents.

Federal
We added the following:

All Detail fields to Worksheet View Summary Grids.
Date of Withdrawal/Deposit to Direct Debit/Deposit Report.
Input reversals for Office Manager default options.
1065 – Form 8082, Notice of Inconsistent Treatment or Administrative Adjustment Request
(AAR).

We added an option to provide compliant presentation for Amended Returns to
provide a blank Form 1065 when Form 8082 is filed (available in 2016).

Form 8975, Country-by-Country Report and Form 8975, Schedule A, Tax Jurisdiction and
Constituent Entity Information.
Descriptions rather than codes in Worksheet drop down fields, so the choice will be visible
without clicking.
Generic State Partner Information is now available in a summary grid format to allow
importing/exporting.

States

Arizona
There are new forms:

AZ 338-P Credit for Investment in Qualified Small Businesses.
AZ 342-P Credit for Renewable Energy Industry.
AZ 343-P Renewable Energy Production Tax Credit.
AZ 345-P Credit For New Employment.

Arkansas
We added the following:

Page 2 for Form AR 1000CR, Composite Return.
Form AR1055-CR, Request for Extension of Time for Filing Composite Income Tax Returns.
Form AR1055-PE, Request for Extension of time for Filing Partnership Tax Returns.

California
California Magnetic Media is retired. Effective January 1, 2018, FTB will discontinue the Paperless
Schedules K-1 (565 or 568) program.

Connecticut
Form CT 1065/1120SI, Schedules B and D, Supplemental Parts 3 through 7 have been changed to
accommodate presentation compliance.
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District of Columbia
We added Combined Reporting Schedule 1A and 1B, Computation of Cost of Goods Sold to provide
support for Combined returns.

Georgia
We added 2D Barcode.

Indiana
We added Schedule Composite-COR, Composite Indiana Adjusted Gross Income Tax Return for
Corporate Entities.

Maryland
We added Form 548, Power of Attorney.

Michigan
We added Form MI-1041ES, Fiduciary Voucher for Estimated Income Tax and Worksheet for
Composite Returns.

Minnesota
We added the following:

Electronic filing for estimates.
Vouchers for Amended Return Payment, Estimated Tax Payment, Tax Return Payment and
Extension Payment.

Nevada
We added NV EXT, Application for 30-day Extension of Time to File and Pay Commerce Tax.

New York
We added state input to support Form IT-398 when Totals Depreciation is used.

Ohio
We added Form UPC, Ohio Universal Payment Coupon.

South Carolina
Electronically filed financial transactions are available for Direct Debit/Deposit.
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Corporation (1120) Product Enhancements - Worksheet View
Return to Table of Contents.

Federal
We added input to produce all state extensions for all states prepared in a return.

Extensions > Federal Extension > Produce all state first extensions

Late Filing Penalty
The minimum late filing penalties for federal returns filed more than 60 days late have been
increased. The penalty is the greater of (a) $210 or (b) 10% of the tax due. This provision applies
to tax years beginning in 2017.

Pro Forma of Estimated Payments
We now pro forma (for informational purposes only) the prior year’s calculated estimated tax
payments in the following year’s return. If there are estimate amounts entered and the
Payments/Penalties > Payments > Federal Tax Payments > Include prior year estimate amounts on
current year return field is selected, we issue a diagnostic indicating we used the keyed amount,
not the memo amount.

Prior Year Estimates as Current Year Tax Payments
The wording for the Office Manager option to include prior year estimates for federal/state
returns as tax payments in next year’s Pro Forma changed from “do NOT Include federal and state
estimate amounts” to “Include federal and state estimate amounts.” If the option is selected,
federal and state payments will be shown as prior year information on the Federal Tax Payments
worksheet and the State Quarterly Payments worksheet.

Suppress Page 1 Statements
We added a Suppress Printing of Statements to all Page 1 statements on General > Return Options >
Processing Options.

Schedule D, Page 2 Part IV Alternative Tax for Corporations with Qualified Timber Gain
This is no longer applicable for 2017.

Form 1120-F

We added a new question CC on Form 1120-F, Page 2.
The input is on Other Returns > 1120-F > General Worksheet Line 44.

If the question is answered “yes”, statement information input on Other
Returns > 1120-F > General worksheet > Line 47 using new Code 5 is
required.

Form 1120-F, Page 3, Section I, Line 2 Dividends now includes two lines, 2a and 2b.
Line 2a Dividends input is on Other Returns > 1120-F > Income NOT Effectively
Connected with U.S. Trade or Business worksheet > Dividends.
Line 2b, Column b input is on Other Returns > 1120-F > Income NOT Effectively
Connected with US Trade or Business worksheet > Line 20.
Line 2b, Column e input is on Payments/Penalties > Federal tax Payments worksheet
with code “Q.”
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Form 1120-H
We added a drill down for Form 1120-H, Page 1, Line C.

Form 1120-L
The restatement of reserves from statutory annual statement to tax return is now automatically
computed for Schedule F Lines 1-6.

We added the following features:

A drill down with A/S source references
A reconciliation from A/S to tax return
Supporting statements included with the tax return
An automatic carry from NAIC import
The ability to change/override all system computations

Form 1120-PC
We added a check box to Form 1120-PC, Page 1, indicating Schedule B is being filed. Questions
added to Page 7 on diversification requirements before filing Schedule B.

The input is on Insurance > 1120-PC > General worksheet > Line 6.

Form 1120-REIT
We added four new lines to Form 1120-REIT, Page 2, Part III – Tax for Failure to Meet Certain
Source-of-Income Requirements: Lines 2b, 2c, 5b, and 5c. Lines 2c and 5c are the same.

The input is on Other Returns > 1120-REIT > Section 857(b)(5), (857(b)(7)(A), and 866(c)(7)
(g)(5)> Lines 21, 22, and 23.

Form 4684 – Casualties and Theft
We added Page 4 for Election to Deduct Federally Declared Disaster Loss in Preceding Tax Year
and Revocation of a Prior Year Election.

The input is on Income / Deductions > Election to Deduct Disaster Loss.

Form 4810
This form is only produced when Form 1120-SF for Settlement Funds is present.

The input is on other Returns > 1102-SF – Settlement Funds > Form 4810.

Form 7004 – Option to Carry Extension Payment to Return
The option defaults wording in Office Manager and Extension > Federal Extension worksheet has
changed from “Do NOT carry extension amount to return” to “Automatically carry extension
payment amount to return.”

Form 7004 – Option added to Produce All State Extensions
We added the option "Produce all state first extensions” to Extensions > Federal Extension.
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Form 8827 – Credit for Prior Year Minimum Tax
Carryover Information will no longer pro forma to Credits > 8827 – Credit for Prior Year Minimum
but Tax worksheet will still pro forma to Credits > Credit Carryover worksheet.

Form 8903
We added a drill down for Form 8903.

Form 8904

Credit for Oil and Gas Production from Marginal Wells is available for the 2017 tax year.
Use Credits > 8904 - Credit for Oil and Gas Production from Marginal Wells to prepare
the credit form.
Use Other Enacted Credits worksheet to claim the credit on Schedule K/K-1.

Special allocation code 5742 is added for allocation of this credit among the shareholders in
the return.

Form 8926 – Disqualified Corporate Interest Expense Disallowed Under 163(j)
We added extensive drill downs to Lines 1a, 1b, 1d, 1f, 2a, 2b, 3a, 3b, 3c, 3d, 4b, 7, and 8a.

Form 8975 and Schedule A (Form 8975)
Country-by-Country Report (Form 8975) and its Schedule A for tax jurisdiction and constituent
entity information are available for both electronic filing and paper filing for 2016 (fiscal year
only) and 2017 tax years.

Use Other > 8975 - Country-by-Country Report worksheet to prepare Form 8975.
Use Other > Schedule A (Form 8975) -Tax Jurisdiction and Constituent Entity Information
worksheet to prepare Schedule A (Form 8975).

Schedule A (Form 8975) - Tax Jurisdiction information can be imported from an Excel® worksheet.

Other > Schedule A (Form 8975) - Tax Jurisdiction Country-by-Country

Constituent Entities information can be imported from an Excel® worksheet to the return.

Export > Constituent Entities of the MNE Group per Tax Jurisdiction

Any additional information of a Tax Jurisdiction can be imported from an Excel® worksheet to the
return.

Export > Tax Jurisdiction Additional Information

Schedule PH (Form 1120)
We added IRS Tests Used to Exclude Items of PHC Income to Schedule PH Lines 18-21.

The input is on Taxes > Schedule PH > Testing for Exclusions to PHC Income worksheet.

Principal Business Activity Codes
The IRS has revised the list of Principal Business Activity Codes on 2017 filing instructions for Form
1120. Please review the list on Form 1120 instructions. There are some additions, some deletions,
and some description changes.
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If the return is pro formaed from the prior year, please check the principal business activity code
on Basic Data > General Information > Business code for accuracy.

Category
2016
Code

2017
Code

Addition/
Deletion/
Change Description Note

Mining 211120 Add Crude Petroleum Extraction

Mining 211130 Add Natural Gas Extraction

General
Merchandise
Stores

452300 Add
General Merchandise Stores,
Incl. Warehouse Clubs and
Supercenters

Rental and
Leasing
Services

532283 Add
Home Health Equipment
Rental

Rental and
Leasing
Services

532284 Add Recreational Goods Rental

Rental and
Leasing
Services

532289 Add
All Other Consumer Goods
Rental

General
Merchandise
Stores

452110 452200 Change Code Department Stores
No change
to
description

Rental and
Leasing
Services

532220 532281 Change Code Formal Wear & Costume Rental
No change
to
description

Rental and
Leasing
Services

532230 532282 Change Code Video Tape and Disc Rental
No change
to
description

General
Merchandise
Stores

452900 Delete
Other General Merchandise
Stores

Rental and
Leasing
Services

532290 Delete Other Consumer Goods Rental

Mining 211110 Delete Oil and Gas Extraction
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Extension Payment Amount
The wording in Office Manager of option “Do not automatically carry extension payment amount
to the return” is now changed to “Automatically carry extension payment amount to the return.”
Therefore, the default is now not to carry the extension payment amount to the return unless the
Office Manager option is checked.

Section 165(i) of Election to Deduct Disaster Loss in the Tax Year Immediately Preceding
Tax

Federal Elections > Deduct Disaster Loss in the Tax Year Immediately Preceding Tax Year of
Disaster section is deleted.

Confirm Accuracy of Data Transferred from Prior Year
A new field is added on General > Basic Data > General > Confirm accuracy of data transferred
from prior year. This is used for some states that require verification of certain identification
information to electronically file. Mark this field to confirm the data accuracy and clear the
disqualifying diagnostic.

Consolidated
We added the following:

Computed Only Totals for Ending Eliminations to Consolidated Balance Sheet.
Schedule M-3 statements for Other Income/Loss items (M-3, Part II, Lines 25 and 28) and for
Other Expense/Deduction Items (M-3, Part III, Line 37).
A consolidated diagnostic when Section 280(c) election is present to elect the reduced
research credit on Form 6765 instead of reducing other deductions differs between the
consolidated return and any separate companies the following diagnostic will be issued:

CAUTION

Section 280(c) election between separate company return(s) and consolidated return is
different. All members of a consolidated return must adopt the same election. Otherwise the
credit computation as well as carryover to future year may be incorrect.

States
We added electronic filing for the following:

District of Columbia consolidated
Nebraska consolidated
North Carolina consolidated

District of Columbia
We combined Reporting Schedule 1A and 1B, Computation of Cost of Goods Sold to provide support
for Combined returns.

Illinois
We added IL-1120 Schedule SA, Specific Accounting Method of Computing Net Income for
Corporations.
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Kentucky
We added Schedule L-C, Limited Liability Entity Tax.

Maryland
We added Form 548, Power of Attorney.

Minnesota
We added the following:

Electronic filing for estimates.
Vouchers for Amended Return Payment, Estimated Tax Payment, Tax Return Payment, and
Extension Payment for 1120 and UBIT.

Nevada
We added NV EXT, Application for 30-day Extension of Time to File and Pay Commerce Tax.

New York
We added separate signature forms to NY TR-579-CT for electronic filing.

New York - New York City
We added separate signature forms to NYC 579-COR for electronic filing.

South Carolina
Electronically filed financial transactions are available for Direct Debit/Deposit.
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S Corporation (1120S) Product Enhancements - Worksheet View
Return to Table of Contents.

Federal
We added input to produce all state extensions for all states prepared in a return.

Extensions > Federal Extension > Produce all state first extensions

Pro Forma of Estimated Payments
We now pro forma (for informational purposes only) the prior year’s calculated estimated tax
payments in the following year’s return. If there are estimate amounts entered and the
Payments/Penalties > Payments > Federal Tax Payments > Include prior year estimate amounts on
current year return field is selected, we issue a diagnostic indicating we used the keyed amount,
not the memo amount.

Prior Year Estimates as Current Year Tax Payments
The Office Manager option to include prior year estimates for federal/state returns as tax
payments in next year’s Pro Forma changed from “do NOT Include federal and state estimate
amounts” to “Include federal and state estimate amounts.”

Form 4684, Page 4
Page 4 of Form 4684 is added for election to deduct federally declared disaster loss in preceding
tax year and revocation of prior election.

Use Income/Deductions > 4684 - Election to Deduct Disaster Loss worksheet to prepare this
page.

Form 7004 – Option to Carry Extension Payment to Return
The option defaults in Office Manager and Extensions > Federal Extension option has changed from
“Do NOT carry extension amount to return” to “Automatically carry extension payment amount to
return.”

Form 7004 – Option to Produce All State Extensions
The option to “Produce all state first extensions” was added to Extensions > Federal Extension.

Form 8904

Credit for Oil and Gas Production from Marginal Wells is available for the 2017 tax year.
Use Credits > 8904 - Credit for Oil and Gas Production from Marginal Wells to prepare
the credit form, or use the Other Enacted Credits worksheet to claim the credit on
Schedule K/K-1.

Special allocation code 5742 is added for allocation of this credit among the shareholders in
the return.
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Form 8975 and Schedule A (Form 8975)

Country-by-Country Report (Form 8975) and its Schedule A for Tax Jurisdiction and
Constituent Entities information are available for both electronic filing and paper filing for
2016 (fiscal year only) and 2017 tax years.

Use Other > 8975 - Country-by-Country Report worksheet to prepare Form 8975.

Use Other > Schedule A (Form 8975) - Tax Jurisdiction and Constituent Entity
Information worksheet to prepare Schedule A (Form 8975).

Schedule A (Form 8975) - Tax Jurisdiction information can be imported from an Excel®

worksheet.
Other > Schedule A (Form 8975) - Tax Jurisdiction Country-by-Country

Constituent Entities information can be imported from an Excel® worksheet.
Export > Constituent Entities of the MNE Group per Tax Jurisdiction

Any additional information of a Tax Jurisdiction can be imported from an Excel® worksheet
to the return under Export > Tax Jurisdiction Additional Information.

Schedule M-3 - Carry M-3 Permanent Differences to SCH K and K-1
New option on Sch. L/M > Schedule M-3 > General and Net Income (Loss) Reconciliation worksheet
to carry permanent differences to Schedule K, Line 16b, other tax-exempt or Line 16c,
nondeductible expenses.

1120S Consolidated
New consolidated option on Consolidated > Options to carry manual income and deduction
adjustments to Schedule M-3.

Shareholder State Information Worksheet
New shareholder state information worksheet added to specific shareholder information section
for import and data entry at the consolidated level.

Shareholder Basis
New drill downs for Shareholder Basis worksheets.

Principal Business Activity Codes

The IRS has revised the list of Principal Business Activity Codes on 2017 filing instructions for
Form 1120S. Please review the list on Form 1120S instructions. There are some additions,
some deletions and some description changes.

If the return is pro formaed from prior year, please check the principal business activity code
on Basic Data > General Information > Business code for its accuracy.

Category
2016
Code

2017
Code

Addition/
Deletion/
Change Description Note

Mining 211120 Add
Crude Petroleum
Extraction
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Category
2016
Code

2017
Code

Addition/
Deletion/
Change Description Note

Mining 211130 Add Natural Gas Extraction

General
Merchandise
Stores

452300 Add
General Merchandise
Stores, Incl. Warehouse
Clubs and Supercenters

Rental and
Leasing
Services

532283
Add

Home Health Equipment
Rental

Rental and
Leasing
Services

532284 Add Recreational Goods Rental

Rental and
Leasing
Services

532289 Add
All Other Consumer Goods
Rental

General
Merchandise
Stores

452110 452200
Change
Code

Department Stores
No change
to
description

Rental and
Leasing
Services

532220 532281
Change
Code

Formal Wear & Costume
Rental

No change
to
description

Rental and
Leasing
Services

532230 532282
Change
Code

Video Tape and Disc
Rental

No change
to
description

General
Merchandise
Stores

452900 Delete
Other General
Merchandise Stores

Rental and
Leasing
Services

532290 Delete
Other Consumer Goods
Rental

Mining 211110 Delete Oil and Gas Extraction

Extension Payment Amount
The wording in Office Manager of option “Do not automatically carry extension payment amount
to the return” is now changed to “Automatically carry extension payment amount to the return.”
Therefore, the default is now not to carry the extension payment amount to the return unless the
Office Manager option is checked.
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Suppression of Printing Overall Statements for Form 1120S
An option is added to suppress all Form 1120S statements on Return Options > Processing Options >
Suppress all statements below.

Section 165(i) of Election to Deduct Disaster Loss in the Tax Year Immediately Preceding
Tax

Federal Elections > Deduct Disaster Loss in the Tax Year Immediately Preceding Tax Year of
Disaster section is deleted.

Confirm Accuracy of Data Transferred from Prior Year
A new field is added on General > Basic Data > General > Confirm accuracy of data transferred
from prior year. This is used for some states that require verification of certain identification
information to electronically file. Mark this field to confirm the data accuracy and clear the
disqualifying diagnostic.

States

Arizona
There are new forms:

AZ 338-S Credit for Investment in Qualified Small Businesses
AZ 342-S Credit for Renewable Energy Industry
AZ 343-S Renewable Energy Production Tax Credit
AZ 345-S Credit For New Employment

Arkansas
We added the following:

Page 2 for Form AR 1000CR, Composite Return.
Form AR1055-CR, Request for Extension of Time for Filing Composite Income Tax Returns.

Connecticut
Form CT 1065/1120SI, Schedules B and D, Supplemental Parts 3 through 7 have been changed to
accommodate presentation compliance.

Delaware
We added Form DE 1100P-EXT, S Corporation Request for Extension.

District of Columbia
We added Combined Reporting Schedule 1A and 1B, Computation of Cost of Goods Sold to provide
support for Combined returns.

Maryland
We added Form 548, Power of Attorney.
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Michigan
We added Form MI-1041ES, Fiduciary Voucher for Estimated Income Tax and Worksheet for
Composite Returns.

Minnesota
We added the following:

Electronic filing for estimates.
Vouchers for Amended Return Payment, Estimated Tax Payment, Tax Return Payment and
Extension Payment.

Nevada
We added NV EXT, Application for 30-day Extension of Time to File and Pay Commerce Tax.

New York
We added separate signature forms for NY TR-579-CT for electronic filing.

New York - New York City
We added the following:

Separate signature forms for NYC 579-COR for electronic filing.
New York City Subchapter S Banking Return is added (It is also added to the 2016 tax year).

Use New York City > New York City Banking worksheet to prepare New York City
banking returns.

Ohio
We added Form UPC, Ohio Universal Payment Coupon.

South Carolina
Electronically filed financial transactions are available for Direct Debit/Deposit.
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Fiduciary (1041) Product Enhancements - Worksheet View
Return to Table of Contents.

Federal
We aligned CONS, 1099INT, and 1099DIV so all entries are available on each.

We added the following:

A Schedule B, Line 10 drill down (Other amounts paid or distributed)
K-1 AMT Workpapers
Self-Charged Interest to passthroughs

Income > Schedule E, Page 2 – Fiduciary Passthrough [K-1 1041] > Interest and
Dividends > Interest
Income > Schedule E, Page 2 – Partnership Passthrough [K-1 1065] > Interest and
Dividends > Interest
Income > Schedule E, Page 2 – Large Partnership Passthrough [K-1 1065-B] > Interest
and Dividends > Interest
Income > Schedule E, Page 2 – S Corporation Passthrough [K-1 1120S] > Interest and
Dividends > Interest

PTP K-1 Aggregation to conform to 1040 change

Federal K-1 withholding overrides
Beneficiaries > Specific Allocation – Other continued > Beneficiary, Grantor, or
Owner’s Specific Allocations – Other – continued > Federal withholding

Withholding boxes for Schedule D transactions (matches 1040) in several locations such as
the following most common:

Income > Sch D / 4797 / 4684 – Gains and Losses [1099-B, I099-S, 2439] > Stocks,
Securities, and Other Non-Passive Transactions > Federal tax withheld AND State tax
withheld
Income > Sch D / 4797 / 4684 – Gains and Losses [1099-B, I099-S, 2439] > Business
Property, Casualty and Theft > Federal tax withheld AND State tax withheld

The ability to state code State Allocations (Beneficiary Information > State K-1 Information >
State tax withheld).

Consistency/Usability Changes

We expanded the use of worksheet view descriptions in lieu of codes.
We added all allowable fields to all summary grids. This means that, whenever possible, each
Summary grid will now contain all the fields found on the Detail grid.
We added a state e-file estimate grid.

The following are improvements made to worksheet navigation:

Form 1116 is listed in both Credits and Foreign (Mirrored entries).
Schedule and Form names are explicitly stated.
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Grid Import Templates
We changed the import template for the Consolidated 1099 Gains and Loss import to match the
import grid for Schedule D. They will now be consistent with each other and match the templates
for 1040.

Extensions
We added a "Prepare All Extensions" option to generate required extensions for all taxing
authorities in a return at Extensions > Automatic Extension > Prepare all extensions.

States
We added electronic filing for the following:

AR – Extension
CA – Grantor trusts
KY – Form 741
NH - Business Profits Tax Return

Note: LA is under consideration, pending receipt of the schema.

California
We added state 8878, extension signature document, to the extension print package.

Illinois
We added Form IL-1041 Schedule SA, Specific Accounting Method of Computing Net Income for
Fiduciaries.

The input is on Income / Deductions > Schedule SA.

Indiana
We added Schedule COMPOSITE-COR, Composite AGI Return for Corporations.

Kentucky
We added the following:

Form 8879-F, Electronic Filing Signature document
Form 741-V, Payment Voucher for electronically filed returns

Louisiana
Presuming electronic filing is added:

Form LA8453F, Fiduciary Income Tax Declaration for Electronic Filing
Form R-6466V (EXT) - Fiduciary Income Tax Electronically Filed Extension Payment Voucher

Maryland
We added Form 504A, Schedule A.
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Massachusetts
We added the following:

Schedule OJC, New Credit for Taxes Paid
2D barcode

Minnesota
We added the following:

Fiduciary Amended Return Payment form
Extension Payment form
Return Payment form

Nevada
We added an application for 30 Day Extension.

New York
We added the following:

Form IT-603, Claim For EZ Investment Tax Credit and EZ Employment Incentive Credit
New York > Credits > EZ ITC and EZ EIC (Form IT-603)

Form IT-219, Credit for New York City Unincorporated Business Tax
New York > Credits > Credit for New York City Unincorporated Business Tax (IT-219)

Form IT-223, Innovation Hot Spot Deduction
New York > Credits > Innovation Hot Spot Deduction [IT-223]

Form IT-249, Claim for Long-Term Care Insurance Credit
New York > Credits > Long Term Care Insurance Credit [IT-249]

Form IT-256, Claim For Special Additional Mortgage Recording Tax Credit
New York > Credits > Claim for Special Additional Mortgage Recording Tax Credit
[IT-256]

Form IT-607, Claim for Excelsior Jobs Program Tax Credit
New York > Credits > Claim for Excelsior Jobs Program Tax Credit [IT-607]

Form IT-398 Input for Assets (like 1120/1120S).
New York > Income / Deductions > Depreciation Adjustment

Forms W2, W2-G, 1099-G (EF only)
New York > E File Options > IRS W-2 OR IRS W-2G OR E-File 1099-G

Form TR-573.2 – NY E-file Mandate Info
State 8878, extension signature document to extension print package

Rhode Island
We added Form 1041-V, Payment Voucher

South Carolina
We added Form I-41, Nonresident Beneficiary Affidavit and Agreement.

Income/Deductions > Other Adjustments, Taxes and Credits > Form I41 print option code
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Virginia
We added Schedule 770-VK-1, Beneficiary Schedule.

Wisconsin
We added the following:

Schedule AR, Explanation of Amended Return.
Other > Amended Return Information > Schedule AR – Explanation of Amended Return

Schedule DC, Development Zone Credits.
Credits > Schedule CR Credits > Development Zones Credit (Schedule DC)

Schedule EC, Enterprise Zone Credit.
Credits > Schedule CR Credits > Enterprise Zone Jobs Credit (Schedule EC)

Schedule ED, Economic Development Tax Credit.
Credits > Schedule CR Credits > Economic Development Tax Credit (Schedule ED)

Schedule HR, Historic Rehabilitation Credit.
Credits > Schedule CR Credits > Historic Rehabilitation Credit (Schedule HR)

Schedule VC, Venture Capital Credits.
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Estate and Gift (706/709) Product Enhancements - Worksheet View
Return to Table of Contents.

There are no updates available with this release.
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Exempt Organization (990) Product Enhancements - Worksheet
View
Return to Table of Contents.

Federal
We added the following:

Input to produce all state extensions for all states prepared in a return ( Extensions > Form
8868 General Information > Produce all state first extensions).
Date of Withdrawal/Deposit to Direct Debit/Deposit Report.
Descriptions rather than codes in Worksheet drop down fields, so the choice will be visible
without clicking.
Detail to Worksheet View Summary Grids.

States

Florida
We added electronic filing.
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Employee Benefit Plan (5500) Product Enhancements - Worksheet
View
Return to Table of Contents.

There are no updates available with this release.
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Tax Product Enhancements 2017.01000 - Interview View

Individual (1040) Product Enhancements - Interview View
Return to Table of Contents.

Federal
We aligned the fields on the Consolidated 1099, 1099-INT, and 1099-DIV source documents
input.
We no longer disqualify e-filed extensions (FD or state) after the due date.

Direct Deposit/Debit
We appended the scheduled date for withdrawal to the text in the Debit/Deposit column, which
will show when the withdrawal is scheduled for all return types, including estimate payments.

1040NR, U.S. Nonresident Alien Income Tax Return

We added e-file for TY 2016.
We added Form 1042-S as a supporting source document.

Library only – required to clear diagnostics that represent IRS rejects.

1099MISC
We added a code for Nonemployee Compensation so the amount will carry to both Other Income
and Schedule SE.

Interview Form IRS-1099MISC, Box 129

Form 5471
We added a new Schedule G, Line 3 statement.

Form 8621 Excess
We improved the look and content of this worksheet by changing it to a small font.

Form 8903
Prior year basis, at-risk and passive domestic production loss carryovers will now carry to Form
8903 and be used in the calculation of QPAI.

Pro Forma of Estimated Payments
We now pro forma (for informational purposes only) the prior year’s calculated estimated tax
payments in the following year’s return. If there are estimate amounts entered and the "Include
prior year estimate amounts on current year return" field is selected on Interview Form T-2, Box
46, we issue a diagnostic indicating we used the keyed amount, not the memo amount.

Extensions
We added the Prepare All Extensions Option to generate required extensions for all taxing
authorities in a return.
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States

Agreements with State Taxing Authorities (Letters of Intent)
We must comply with the following requirements from States governing paper and e-file
submissions:

Restrictions on Pro Forma (transfer of data)
The following states will not allow us to pro forma driver's license numbers and State
IDs: AL, CT, IA, ID, IN, ME, NC, ND, NE, NJ, NM, OK, WI.
The following states will not allow us to pro forma bank information (account
numbers), driver's license numbers, or State IDs: AR, IL, SC, WV.

This state will not allow us to pro forma driver’s license number, State ID, bank
information, State PINs or locality codes: VA.
The following states require the preparer to confirm pro formaed data: CO, KY, MD,
MN.
The following states require two-step verification of various items: AR, OR.

Most states now require us to include refund/ID theft statements and associated URLs in the
return (this is handled in Help).
We will disqualify the return from e-file if driver's license information is not in the return
for: AL, CT, NM, NY and OH. Per these States, you will not be able to electronically file
these returns until you enter the information.

Alabama
We added Schedule IRC – Irrigation/Reservoir System Credit.

Interview Form AL9A

Arkansas
We added AR1000CE, Teacher’s Classroom Investment Expense.

Interview Form AR9

California
We added the following:

State 8878, extension signature document to extension print package
Schedule X – Amended Return Worksheet

Colorado
We added the following:

EF estimates
Interview Form CO1, Box 61

DR 0350 – First Time Home Buyers Subtraction
Interview Form CO2, Boxes 55 – 63

District of Columbia
We are no longer offering a refund card as an option due to new requirements.
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Kansas
There is a new three-bracket rate structure.

Kentucky
We added Schedule KW-2, Kentucky Income Tax Withheld (mandatory for paper filed returns
only).

Massachusetts
We changed the default for MA bank interest that is applied to MA resident returns.

Michigan
Form 1040X is obsolete and has been replaced by Form 5530.

Michigan – DTW
We added Detroit Form 5338, Underpayment of Estimated Tax

Interview Form DTW5A

Minnesota
We added the following:

Schedule M1529, Education Savings Account Contribution Credit or Subtraction
Interview Form MN11, Box 50-56

Schedule M1SLC, Student Loan Credit
Interview Form MN11, Boxes 80-87

Schedule M1RCR, Credit for Tax Paid to Wisconsin
Interview Form MN12, Boxes 50-64

Schedule M1HOME, First-Time Homebuyer Savings Account
Schedule M1AR, Accelerated Recognition of Installment Sale Gains
Credit for Taxes Paid worksheet for e-file

Missouri - St. Louis
We added Form E-8, Application for Extension of Time to File Business Earnings Tax Return.

Montana

An Amended return is now included on Form 2.
Interview Form MT13

NOL information is now included on Form 2
Interview Form MT14

Nevada
We added an Application for 30 Day Extension.
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New Hampshire

We added Business Profits Tax e-file.
We removed the sole proprietor versions of the Business Profits Tax forms. LLC versions are
available exclusively.

New York
We added the following:

State 8878, extension signature document to extension print package
Form IT-219, Credit for New York City Unincorporated Business Tax

Interview Form NY13, Boxes 80 – 92

Form IT-223, Innovation Hot Spot Deduction
Interview Form NY39, Boxes 80 – 125

Form IT-249, Claim for Long-Term Care Insurance Credit
Interview Form NY15, Boxes 30 – 51

Form IT-256, Claim For Special Additional Mortgage Recording Tax Credit
Interview Form NY16, Boxes 30 – 68

Form IT-603, Claim For EZ Investment Tax Credit and EZ Employment Incentive Credit
Interview Form NY35

Form IT-607, Claim for Excelsior Jobs Program Tax Credit
Interview Form NY37, Boxes 50 – 74

Form IT-398 Input for Assets as in 1120/1120S
Interview Form NY41

Forms W2, W2-G, 1099-G-EF only
Interview Forms IRS-W2, IRS-W2G, and IRS-1099G

New York - New York City
We added city 8878 signature document to extension print package.

North Carolina
We added Schedule PN, Part-year Resident and Nonresident Schedule.

Oregon
We added the following:

OR-WFHDC, Oregon Working Family Household and Dependent Care Credit Worksheet
Interview Forms OR7 and OR8

Retention document for calculating prior year Working Family and Household Add Dependent
Care Credit

Interview Form OR8
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Pennsylvania

We separated Schedule G-L override logic in the following manner:
One override no longer requires all fields to be overridden.

Existing input has been updated to include only one column with a TS code to
indicate taxpayer or spouse.

Schedule A/B will not split into separate schedules if any overrides are entered.
We now treat the Taxpayer/Joint column as jointly filed input if all other entries are coded
joint and as Taxpayer input if any other entries are coded as Taxpayer or Spouse (Interview
Form PA1A and Interview Form PA1B).
We added an option to force separate schedules.
Overrides have been expanded to all lines.

South Carolina
We added an Out of State Income/Loss statement.

The new adjustment options added for this are on Interview Form SC1, Box 44.

Tennessee
We added FAE172, Quarterly Franchise, Excise Tax Declaration e-file.

Interview Form TN4, Boxes 30 - 48

Vermont
We added the ability to batch e-file extensions.

Wisconsin
We added the following:

Schedule GL, Gain or Loss on the Sale of Your Home
Interview Form WI10, Boxes 60-69

Credit for Taxes Paid worksheet for e-file
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Partnership (1065) Product Enhancements - Interview View
Return to Table of Contents.

Federal
We added the following:

Date of Withdrawal/Deposit to Direct Debit/Deposit Report
Input reversals for Office Manager default options
1065 – Form 8082, Notice of Inconsistent Treatment or Administrative Adjustment Request
(AAR)

Including an option to provide compliant presentation for Amended Returns to
provide a blank Form 1065 when Form 8082 is filed (available in 2016)

Form 8975, Country-by-Country Report and Form 8975, Schedule A, Tax Jurisdiction and
Constituent Entity Information

States

Arizona
The following are new forms:

AZ 338-P Credit for Investment in Qualified Small Businesses
AZ 342-P Credit for Renewable Energy Industry
AZ 343-P Renewable Energy Production Tax Credit
AZ 345-P Credit For New Employment

Arkansas
We added the following:

Page 2 for Form AR 1000CR, Composite Return
Form AR1055-CR, Request for Extension of Time for Filing Composite Income Tax Returns
Form AR1055-PE, Request for Extension of time for Filing Partnership Tax Returns

California
California Magnetic Media is retired. Effective January 1, 2018, FTB will discontinue the Paperless
Schedules K-1 (565 or 568) program.

Connecticut
Form CT 1065/1120SI, Schedules B and D, Supplemental Parts 3 through 7 have been changed to
accommodate presentation compliance.

District of Columbia
We added Combined Reporting Schedule 1A and 1B, Computation of Cost of Goods Sold to provide
support for Combined returns.

Georgia
We added 2D Barcode.
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Indiana
We added Schedule Composite-COR, Composite Indiana Adjusted Gross Income Tax Return for
Corporate Entities.

Maryland
We added Form 548, Power of Attorney.

Michigan
We added Form MI-1041ES, Fiduciary Voucher for Estimated Income Tax and Worksheet for
Composite Returns.

Minnesota
We added the following:

Electronic filing for estimates
Vouchers for Amended Return Payment, Estimated Tax Payment, Tax Return Payment and
Extension Payment

Nevada
We added Form NV EXT, Application for 30-day Extension of Time to File and Pay Commerce Tax.

New York
We added state input to support Form IT-398 when Totals Depreciation is used.

Ohio
We added Form UPC, Ohio Universal Payment Coupon.

South Carolina
Electronically filed financial transactions are available for Direct Debit/Deposit.
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Corporation (1120) Product Enhancements - Interview View
Return to Table of Contents.

Federal
We added input to produce all state extensions for all states prepared in a return.

Interview Form EXT-1, Box 120

Late Filing Penalty
The minimum late filing penalties for federal returns filed more than 60 days late have been
increased. The penalty is the greater of (a) $210 or (b) 10% of the tax due. This provision applies
to tax years beginning in 2017.

Pro Forma of Estimated Payments
We now pro forma (for informational purposes only) the prior year’s calculated estimated tax
payments in the following year’s return. If there are estimate amounts entered and the "Include
prior year estimate amounts on current year return" field is selected on Interview Form T-2, Box
46, we issue a diagnostic indicating we used the keyed amount, not the memo amount.

Prior Year Estimates as Current Year Tax Payments
The wording for the Office Manager option to include prior year estimates for federal/state
returns as tax payments in the next year’s Pro Forma changed from “do NOT Include federal and
state estimate amounts” to “Include federal and state estimate amounts.” If the option is
checked, federal estimates will pro forma to Interview Form P-1, Boxes 30 through 46 and state
estimates will pro forma to STPAY-1, Boxes 31 - 57.

Suppress Page 1 Statements
We added a Suppress Printing of Statements option on Page 1 statements on Form 4A, Box 70.

Schedule D, page 2 Part IV Alternative Tax for Corporations with Qualified Timber Gain
This is no longer applicable for 2017.

Form 1120-F

We added a new question CC on Form 1120-F, Page 2.
The input is on Interview Form FC-1, Box 73.

If the question is answered “yes,” statement information input on FC-4, Box
35 with the new code "5" on Box 34 is required.

We added overrides for dividend equivalents.
Items on Federal Interview Form FC-2, Boxes 105-107.

Form 1120-F, Page 3, Section I, Line 2 Dividends now includes Lines 2a and 2b.
Line 2a, Dividends input is on Interview Form FC-2, Boxes 84 through 95.

Line 2b, Column b input is on Interview Form FC-2, Box 96.

Line 2b, Column e input is on Interview Form P-1, Box 31.

Form 1120-H
We added a drill down for Form 1120-H, Page 1, Line C.
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Form 1120-L

The restatement of reserves from statutory annual statement to tax return is now
automatically computed for Schedule F, Lines 1-6.

The following features have been added:

A drill down with A/S source references
A reconciliation from A/S to tax return
Supporting statements included with tax return
An automatic carry from NAIC import
The ability to change/override all system computations with code “Q” on Box 32

Form 1120-PC
We added a check box to Form 1120-PC, Page 1, indicating Schedule B is being filed and questions
to Page 7 on diversification requirements before filing Schedule B.

Interview Form PC-1, Box 37

Form 1120-REIT
We added four new lines (2b, 2c, 5b, and 5c) to Form 1120-REIT, Page 2, Part III – Tax for Failure
to Meet Certain Source-of-Income Requirements (Lines 2c and 5c are the same).

The input is on Interview Form REIT-2, Boxes 61, 62, and 63.

Form 4684 – Casualties and Theft
We added Page 4 to Elect to Deduct Federally Declared Disaster Loss in Preceding Tax year and
Revoke a Prior Year Election.

The input is on Interview Form D-1B.

Form 4810
This form is only produced when Form 1120-SF for Settlement Funds is present.

The input is on Interview Form SF-2.

Form 7004 – Option to Carry Extension Payment to Return
This option defaults in Office Manager and Interview Form EXT-1, Box 48 has changed from “Do
NOT carry extension amount to return” to “Automatically carry extension payment amount to
return.”

Form 7004 – Option added to Produce All State Extensions
We added the option “X to produce all state first extensions” to Interview Form EXT-1, Box 120.

Form 8827 – Credit for Prior Year Minimum Tax
Carryover Information will no longer pro forma to Interview Form P-1A, Box 41, but it will still pro
forma to Interview Form A-5.

Form 8903
We added a drill down for Form 8093.
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Form 8904

Credit for Oil and Gas Production from Marginal Wells is available for the 2017 tax year.
Use Federal Interview Form P-8 to prepare the credit form.

Use Federal Interview Form P-14, Box 33 to claim the credit on Schedule K/K-1.

Special allocation code 5742 is added for allocation of this credit among the shareholders in
the return.

Form 8926 – Disqualified Corporate Interest Expense Disallowed Under 163(j)
We added extensive drill downs to Lines 1a, 1b, 1d, 1f, 2a, 2b, 3a, 3b, 3c, 3d, 4b, 7, and 8a.

Form 8975 and Schedule A (Form 8975)
Country-by-Country Report (Form 8975) and its Schedule A for tax jurisdiction and constituent
entity information are available for both electronic filing and paper filing for 2016 (fiscal year
only) and 2017 tax years.

Use Federal Interview Form FCR1 to prepare Form 8975.
Use Federal Interview Form FCR2 to Schedule A (Form 8975).

Schedule PH (Form 1120)
We added IRS Tests Used to Exclude Items of PHC Income added to Schedule PH, Lines 18-21.

The input is on Interview Form PH-3.

Principal Business Activity Codes
The IRS has revised the list of Principal Business Activity Codes on 2017 filing instructions for Form
1120. Please review the list on Form 1120 instructions. There are some additions, some deletions,
and some description changes.

If the return is pro formaed from the prior year, please check the principal business activity code
on Federal Interview Form 1, Box 53 for accuracy.

Category
2016
Code

2017
Code

Addition/
Deletion/
Change Description Note

Mining 211120 Add Crude Petroleum Extraction

Mining 211130 Add Natural Gas Extraction

General
Merchandise
Stores

452300 Add
General Merchandise Stores,
Incl. Warehouse Clubs and
Supercenters

Rental and
Leasing
Services

532283 Add
Home Health Equipment
Rental

Rental and
Leasing 532284 Add Recreational Goods Rental
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Category
2016
Code

2017
Code

Addition/
Deletion/
Change Description Note

Rental and
Leasing
Services

532289 Add
All Other Consumer Goods
Rental

General
Merchandise
Stores

452110 452200 Change Code Department Stores
No change
to
description

Rental and
Leasing
Services

532220 532281 Change Code Formal Wear & Costume Rental
No change
to
description

Rental and
Leasing
Services

532230 532282 Change Code Video Tape and Disc Rental
No change
to
description

General
Merchandise
Stores

452900 Delete
Other General Merchandise
Stores

Rental and
Leasing
Services

532290 Delete Other Consumer Goods Rental

Mining 211110 Delete Oil and Gas Extraction

Extension Payment Amount
The wording in Office Manager of option “Do not automatically carry extension payment amount
to the return” is now changed to “Automatically carry extension payment amount to the return.”
Therefore, the default is now not to carry the extension payment amount to the return unless the
Office Manager option is checked.

Section 165(i) of Election to Deduct Disaster Loss in the Tax Year Immediately Preceding
Tax

Federal Interview Form FE-3, Boxes 80 - 83 are deleted.

Confirm Accuracy of Data Transferred from Prior Year
A new field is added on Federal Interview Form 1, Box 110. This is used for some states that
require verification of certain identification information to electronically file. Mark this field to
confirm the data accuracy and clear the disqualifying diagnostic.
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Consolidated
We added the following:

Computed Only Totals for Ending Eliminations to the Consolidated Balance Sheet
Schedule M-3 statements for Other Income/Loss items (M-3, Part II, Lines 25 and 28) and for
Other Expense/Deduction Items (M-3, Part III, Line 37).
A consolidated diagnostic when Section 280(c) election is present to elect the reduced
research credit on Form 6765 instead of reducing other deductions differs between the
consolidated return and any separate companies the following diagnostic will be issued:

CAUTION

Section 280(c) election between separate company return(s) and consolidated return is
different. All members of a consolidated return must adopt the same election. Otherwise the
credit computation as well as carryover to the future year may be incorrect.

States
We added electronic filing for the following:

District of Columbia consolidated

Nebraska consolidated

North Carolina consolidated

District of Columbia
We combined Reporting Schedule 1A and 1B, Computation of Cost of Goods Sold to provide support
for Combined returns.

Illinois
We added IL-1120 Schedule SA, Specific Accounting Method of Computing Net Income for
Corporations.

Kentucky
We added Schedule L-C, Limited Liability Entity Tax.

Maryland
We added Form 548, Power of Attorney.

Minnesota
We added the following:

Electronic filing for estimates.
Vouchers for Amended Return Payment, Estimated Tax Payment, Tax Return Payment, and
Extension Payment for 1120 and UBIT.

Nevada
We added Form NV EXT, Application for 30-day Extension of Time to File and Pay Commerce Tax.
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New York
We added separate signature forms in NY TR-579-CT for electronic filing.

New York - New York City
We added separate signature forms in NYC 579-COR for electronic filing.

South Carolina
Electronically filed financial transactions are available for Direct Debit/Deposit.

Tax Product Enhancements 2017.01000 - Interview View • 48



S Corporation (1120S) Product Enhancements - Interview View
Return to Table of Contents.

Federal
We added input to produce all state extensions for all states prepared in a return.

Interview Form EXT-1, Box 120

Pro Forma of Estimated Payments
We now pro forma (for informational purposes only) the prior year’s calculated estimated tax
payments in the following year’s return. If there are estimate amounts entered and the "Include
prior year estimate amounts on current year return" field is selected on Interview Form T-2, Box
46, we issue a diagnostic indicating we used the keyed amount, not the memo amount.

Prior Year Estimates as Current Year Tax Payments
The wording for the Office Manager option to include prior year estimates for federal/state
returns as tax payments in next year’s Pro Forma changed from “do NOT Include federal and state
estimate amounts” to “Include federal and state estimate amounts.”

Form 4684, Page 4
We added Page 4 of Form 4684 for election to deduct federally declared disaster loss in preceding
tax year and revocation of prior election.

Use federal Interview Form D-1B to prepare this page.

Form 7004 – Option to Carry Extension Payment to Return
The option defaults in Office Manager and Interview Form EXT-1, Box 48 have changed from “Do
NOT carry extension amount to return” to “Automatically carry extension payment amount to
return.”

Form 7004 – Option to Produce All State Extensions
The option “X to produce all state first extensions” was added to Interview Form EXT-1, Box 120.

Form 8904
The Credit for Oil and Gas Production from Marginal Wells is available for the 2017 tax year.

Use Federal Interview Form P-8 to prepare the credit form, or use Federal Interview Form P-
14, Box 33 to claim the credit on Schedule K/K-1.
Special allocation code 5742 is added for allocation of this credit among the shareholders in
the return.

Form 8975 and Schedule A (Form 8975)
These forms have been added to report certain information with respect to U.S. Multi-National
Entity group on a country-by-country basis.

The input is on Interview Form FCR-1.
The input for Schedule A (Form 8975) is on Interview FCR-2.
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Schedule M-3 - Carry M-3 Permanent Differences to SCH K and K-1
There is a new option on Interview Form L-5, Box 110 to carry permanent differences to SCH K,
Line 16b, Other Tax-Exempt Income or to Line 16c, Nondeductible Expenses.

1120S Consolidated
There is a new consolidated option on Interview Form CC-1, Box 132 to carry manual income and
deduction adjustments to Schedule M-3.

Shareholder Basis
There are new drill downs for Shareholder Basis worksheets.

Principal Business Activity Codes
The IRS has revised the list of Principal Business Activity Codes on 2017 filing instructions for Form
1120S. Please review the list on Form 1120S instructions. There are some additions, some
deletions, and some description changes.

If the return is pro formaed from the prior year, please check the principal business activity code
on federal Interview Form 1, Box 53 for accuracy.

Category
2016
Code

2017
Code

Addition/
Deletion/
Change Description Note

Mining 211120 Add Crude Petroleum Extraction

Mining 211130 Add Natural Gas Extraction

General
Merchandise
Stores

452300 Add
General Merchandise Stores,
Incl. Warehouse Clubs and
Supercenters

Rental and
Leasing
Services

532283 Add
Home Health Equipment
Rental

Rental and
Leasing
Services

532284 Add Recreational Goods Rental

Rental and
Leasing
Services

532289 Add
All Other Consumer Goods
Rental

General
Merchandise
Stores

452110 452200 Change Code Department Stores
No change
to
description

Rental and
Leasing
Services

532220 532281 Change Code Formal Wear & Costume Rental
No change
to
description
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Category
2016
Code

2017
Code

Addition/
Deletion/
Change Description Note

Rental and
Leasing
Services

532230 532282 Change Code Video Tape and Disc Rental
No change
to
description

General
Merchandise
Stores

452900 Delete
Other General Merchandise
Stores

Rental and
Leasing
Services

532290 Delete Other Consumer Goods Rental

Mining 211110 Delete Oil and Gas Extraction

Extension Payment Amount
The wording in Office Manager of option “Do not automatically carry extension payment amount
to the return” is now changed to “Automatically carry extension payment amount to the return.”
Therefore, the default is now not to carry the extension payment amount to the return unless the
Office Manager option is checked.

Suppression of Printing Overall Statements for Form 1120S
An option is added to suppress all Form 1120S statements on Federal Interview Form 4, Box 120.

Section 165(i) of Election to Deduct Disaster Loss in the Tax Year Immediately Preceding
Tax

Federal Interview Form FE-3, Boxes 80 - 83 are deleted.

Confirm Accuracy of Data Transferred from Prior Year
A new field is added on Federal Interview Form 1, Box 110. This is used for some states that
require verification of certain identification information to electronically file. Mark this field to
confirm the data accuracy and clear the disqualifying diagnostic.

States

Arizona
The following are new forms:

AZ 338-S Credit for Investment in Qualified Small Businesses
AZ 342-S Credit for Renewable Energy Industry
AZ 343-S Renewable Energy Production Tax Credit
AZ 345-S Credit For New Employment
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Arkansas
The following have been added:

Page 2 for Form AR 1000CR, Composite Return
Form AR1055-CR, Request for Extension of Time for Filing Composite Income Tax Returns

Connecticut
Form CT 1065/1120SI, Schedules B and D, Supplemental Parts 3 through 7 have been changed to
accommodate presentation compliance.

Delaware
We added Form DE 1100P-EXT, S Corporation Request for Extension.

District of Columbia
We added Combined Reporting Schedule 1A and 1B, Computation of Cost of Goods Sold to provide
support for Combined returns.

Maryland
We added Form 548, Power of Attorney.

Michigan
We added Form MI-1041ES, Fiduciary Voucher for Estimated Income Tax and Worksheet for
Composite Returns.

Minnesota
We added the following:

Electronic filing for estimates
Vouchers for Amended Return Payment, Estimated Tax Payment, Tax Return Payment, and
Extension Payment

Nevada
We added Form NV EXT, Application for 30-day Extension of Time to File and Pay Commerce Tax.

New York
We added separate signature forms to NY TR-579-CT for electronic filing.

New York - New York City
We added separate signature forms to NYC 579-COR for electronic filing.

Ohio
We added Form UPC, Ohio Universal Payment Coupon.

South Carolina
Electronically filed financial transactions are available for Direct Debit/Deposit.
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Fiduciary (1041) Product Enhancements - Interview View
Return to Table of Contents.

Federal
We aligned CONS, 1099INT, and 1099DIV so all entries are available on each.

We added the following:

A Schedule B, Line 10 drill down (Other amounts paid or distributed)
K-1 AMT Workpapers
Self-Charged Interest to passthroughs.

Interview Form IRS K-1 1041, Box 183

Interview Form IRS K-1 1065, Box 297

Interview Form IRS K-1 1120S, Box 273

Federal K-1 withholding overrides
Interview Form K-5A, Box 79

Withholding boxes for Schedule D transactions (matches 1040) n several locations. The most
common are as follows:

Interview Form D-1, Boxes 256 and 257 

Interview Form D-1A, Boxes 122 and 123 

Interview Form D-2, Boxes 180 and 181 

The ability to state code State Allocations (Interview Form K-7, Box 126)

Grid Import Templates
We changed the import template for the Consolidated 1099 Gains and Loss import to match the
import grid for Schedule D. They will now be consistent with each other and match the templates
for 1040.

Extensions
We added a "Prepare All Extensions" option to generate required extensions for all taxing
authorities in a return.

Interview Form EXT-1, Box 40

States
We added electronic filing for the following:

AR – Extension
CA – Grantor trusts
KY – Form 741
NH - Business Profits Tax Return

Note: LA is under consideration, pending receipt of the schema.

California
We added the state 8878, extension signature document to the extension print package.
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Illinois
We added a Form IL-1041, Schedule SA, Specific Accounting Method of Computing Net Income for
Fiduciaries.

Interview Form IL23

Indiana
We added Schedule COMPOSITE-COR, Composite AGI Return for Corporations.

Kentucky
We added the following:

Form 8879-F, Electronic Filing Signature document
Form 741-V, Payment Voucher for electronically filed returns

Louisiana
Presuming electronic filing is added:

Form LA8453F, Fiduciary Income Tax Declaration for Electronic Filing
Form R-6466V (EXT) - Fiduciary Income Tax Electronically Filed Extension Payment Voucher

Maryland
We added Form 504A, Schedule A.

Massachusetts
We added the following:

Schedule OJC, New Credit for Taxes Paid
2D barcode

Minnesota
We added the following:

Fiduciary Amended Return Payment Form
Extension Payment Form
Return Payment Form

Nevada
We added an Application for 30 Day Extension.

New York
We added the following:

Form IT-603, Claim For EZ Investment Tax Credit and EZ Employment Incentive Credit
Interview Form NY23

Form IT-219, Credit for New York City Unincorporated Business Tax
Interview Form NY21
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Form IT-223, Innovation Hot Spot Deduction
Interview Form NY21

Form IT-249, Claim for Long-Term Care Insurance Credit
Interview Form NY21

Form IT-256, Claim For Special Additional Mortgage Recording Tax Credit
Interview Form NY22

Form IT-607, Claim for Excelsior Jobs Program Tax Credit
Interview Form NY21

Form IT-398 Input for Assets as in 1120/1120S
Interview Form NY25

Forms W2, W2-G, 1099-G-EF only
Interview Forms NY16A, NY16B, NY16C

Form TR-573.2 – NY E-file Mandate Info.
State 8878, extension signature document to extension print package

Rhode Island
We added Form 1041-V, Payment Voucher.

South Carolina
We added Form I-41, Nonresident Beneficiary Affadavit and Agreement.

Interview Form SC2, Box 38

Virginia
We added Schedule 770-VK-1, Beneficiary Schedule.

Wisconsin
We added the following:

Schedule AR, Explanation of Amended Return
Interview Form WI15, Boxes 60-75

Schedule DC, Development Zone Credits
Interview Form WI24, Boxes 30-65

Schedule EC, Enterprise Zone Credit
Interview Form WI23, Boxes 30-45

Schedule ED, Economic Development Tax Credit
Interview Form WI23, Boxes 50-85

Schedule HR, Historic Rehabilitation Credit
Interview Form WI25, Boxes 30-81

Schedule VC, Venture Capital Credits
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Estate and Gift (706/709) Product Enhancements - Interview View
Return to Table of Contents

There are no updates available with this release.
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Exempt Organization (990) Product Enhancements - Interview View
Return to Table of Contents.

Federal
We added the following:

Input to produce all state extensions for all states prepared in a return (Interview Form EXT-
1, Box 45).
The Date of Withdrawal/Deposit to the Direct Debit/Deposit Report.

States

Florida
We added electronic filing.
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Employee Benefit Plan (5500) Product Enhancements - Interview
View
Return to Table of Contents.

There are no updates available with this release.
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